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Predgovor 

Ideja za ovaj završni rad proizlazi iz dugogodišnjeg hobija kojeg sam usvojio još u osnovnoj 

školi i povezuje obradu videomaterijala s mojom tadašnjom strasti, videoigricama. 

Eksperimentiranje s grafičkim materijalom u tim ranim danima u svrhu hvaljenja i dijeljenja s 

prijateljima je jedan od primarnih razloga zašto se u meni pojavila želja za studiranjem 

multimedijskog sadržaja, te je nostalgični osvrt na tehnike koje sam tada naučio, kao i daljnje 

istraživanje istih, idealna tema vrijedna razmatranja. Cilj rada je uvođenje čitatelja u svijet 

montaže videomaterijala za videoigre, te proširenje i usavršavanje vlastitih sposobnosti. 

 

Ovim putem zahvaljujem mentoru mr.sc. Draganu Matkoviću, za genijalnu potporu i pruženu 

pomoć tijekom pisanja i izrade rada.  



 

 

Sažetak 

 

U završnom radu je na opširan način prikazan proces izrade složenije montaže specifično 

zabavnog videomaterijala preuzetog iz videoigre League of Legends, u svrhu publikacije i 

dijeljenja na internetskim lokacijama kao što su YouTube, Facebook, ili bilo koja druga lokacija 

gdje postoji potražnja za takvim materijalom. 

Završni rad upoznaje čitatelja s načinom korištenja hub programa u kojemu se izvodi projekt, 

odnosno glavnoga softvera u kojemu se odvija velika većina uređivanja i iz kojega je finalizirani 

projekt naposljetku izveden. Softver u pitanju je Magix Vegas Pro verzija 17. Uz njega je za 

kompliciranije vizualne efekte korišten još dodatni softver Adobe Photoshop CS6 i Adobe After 

Effects 2020, te Maxon CINEMA 4D Studio R15. 

Praktični dio rada rezerviran je za eksploraciju metoda korištenih u izvođenju projekta od 

koraka osmišljavanja do izvoza završenog videouratka, odmah nakon spomenutog upoznavanja s 

alatima kao osnove materije potrebne za pravilno i puno razumijevanje naprednijeg teksta koji 

slijedi. U sklopu toga nalazi se i navod uz objašnjene svih korištenih tehnika uređivanja u 

svakom pojedinom korištenom softveru, te naposljetku i kratka referenca i na sam proces 

publikacije završenog projekta. 

 

 

 

Ključne riječi: montaža, zabavni videomaterijal, League of Legends (videoigra), Vegas Pro, 

Photoshop, After Effects, CINEMA 4D, tehnike uređivanja, publikacija na internetu 

  



 

 

Abstract 

 

The final paper contains an extensive showcase of the process of creating an elaborate 

montage of specifically entertainment content taken from the video game League of Legends, for 

the purposes of publication and sharing on internet platforms such as YouTube, Facebook, or 

any other platform where a demand for similar content would exist. 

The final paper introduces the reader to ways of using the hub program in which the project 

is being formed, or rather of the main software within which the majority of the video editing is 

conducted, as well as of the software from which the finalized project is ultimately exported. The 

software in question is Magix Vegas Pro version 17. For the more complicated visual effects, 

additional software (Adobe Photoshop CS6, Adobe After Effects 2020 and Maxon CINEMA 4D 

Studio R15) is also used alongside the hub software. 

The data and analysis portion of the paper is reserved for an exploration of the methods used 

during the creative process of the project, from the point of the project's conception to the point 

of the finalized video product's exportation, directly following the aforementioned introduction 

to the tools used in editing meant to provide the reader with the basic knowledge required to 

achieve a proper and thorough understanding of the more complex text that follows the 

introduction. The data and analysis portion of the paper also contains mentionings and following 

explanations of all editing techniques used during the project's creation within their respective 

software, as well as a brief reference to the publication process of the finalized project to 

conclude the paper. 

 

 

 

Keywords: montage, entertainment content, League of Legends (video game), Vegas Pro, 

Photoshop, After Effects, CINEMA 4D, editing techniques, online publication 
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1. Uvod 

Grafičko i videouređivanje su već dugi niz desetljeća brzorastuća zanimanja u današnjem 

svijetu koja će se, sudeći po količini potražnje grafike i grafičkih stručnjaka, u budućnosti samo 

nastaviti raširivati. Uraci videourednika mogu se pronaći u svakom dostupnom mediju: u sklopu 

televizijskih programa i prijenosa, sve animacije, videomaterijali i obrađene slike koje korisnici 

imaju mogućnost pronaći diljem interneta, sav grafički reklamni materijal, sve profesionalne i 

amaterske montaže ozbiljnog ili zabavnog materijala, svi filmski uraci i slično, lista nema kraja. 

Filmska industrija, odnosno industrija „pokretnih slika“ (eng. moving pictures) svoje začetke 

pronalazi u posljednjem desetljeću devetnaestog stoljeća izumom Edison kinetoskopa britanca 

William Kennedy Laurie Dicksona. [15] Kroz sljedeće stoljeće i pol, filmska industrija bilježi 

nevjerojatnu ekspanziju do danas kada glasi kao jedna od naj prepoznatljivijih luksuznih zanata 

na svijetu. Najvještiji glumci i glumice koji se profesionalno bave filmskom industrijom u očima 

javnosti su proglašeni „filmskim zvijezdama“, te imaju milijune obožavatelja diljem svijeta. 

Akademska nagrada, nagrada dodjeljivana osobama koje su ostvarile značajna tehnička ili 

umjetnička postignuća povezana za filmsku industriju, poznatija kao Oskar, postala je 

prepoznatljiva svakoj osobi koja ima mogućnost pristupa kinima ili televizijskim programima. 

Uz svijet grafike i videouređivanja s razvitkom tehnologije osobnih računala i porasta interesa 

javnosti za korištenjem istih komplementarno se također razvijao i svijet interaktivnog zabavnog 

materijala dostupnog korisnicima svih dobi, prvenstveno zabavnih animacija i videoigara. Danas 

je svijet videoigara dosegao nevjerojatne razine, sa stotinama milijuna aktivnih i strastvenih 

igrača diljem svijeta. Po rezultatima anketa provedenih u Sjedinjenim Američkim Državama 

2018. godine zaključeno je kako dvije trećine cjelokupne populacije stanovnika države igra neku 

vrstu videoigre kao hobi, bilo to na platformi osobnih računala, konzolama, ili mobilnim 

uređajima. [16] Značajnom dočaravanju eksponencijalnog rasta industrije videoigara u 

modernom svijetu doprinosi činjenica kako je 2017. godine zabilježeno blizu dvije tisuće i petsto 

aktivnih konkurentnih tvrtki koje se bave programiranjem i kreacijom videoigara sa 

procijenjenom vrijednošću cjelokupne industrije od dvjesto trideset milijardi američkih dolara 

isključivo u Sjedinjenim Američkim Državama, sa mnogo većim brojem konkurentnih tvrtki i 

mnogo većim cjelokupnim iznosom vrijednosti spomenute brzorastuće industrije ukoliko se na 

razvoj iste gleda kroz globalnu prizmu. 
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Istovremeni razvoj spomenutih dviju danas velikih industrija kreirao je želju korisnika sa 

podijeljenim interesom za oba zanata za personalizirano spajanje istih. U mnogim igračima 

videoigara se s vremenom probudila želja za dijeljenje sadržaja svoga često najdražeg hobija s 

ostalim zainteresiranim osobama diljem svijeta. Spomenuta želja je sama od sebe s vremenom 

kreirala grananje u industriji videoigara, te stvorila specijaliziranije zanate kao npr. profesionalne 

igrače videoigrica (koji se sa svojim vještinama natječu jedni s drugima pred publikom na 

velikim događanjima), zabavljače odnosno streamere (koji na web platformama kao Twitch 

brojnoj publici emitiraju zabavni sadržaj videoigara uz pridodavanje vlastite osobnosti u svrhu 

zabavljanja gledatelja), stručne osobe koje su odabrale baviti se slojevitim obrađivanjem 

zabavnog sadržaja videoigara i njegovim naknadnim objavljivanjem na web lokacijama poput 

YouTube platforme u svrhu zarađivanja od reklamnog sadržaja kojega platforma automatski 

inkorporira unutar njihovog originalnog filmskog sadržaja uslijed dogovaranja partnerstva - 

efektivno najbliže spojivši zanate filmske produkcije sa šarmom industrije videoigara putem 

medija videomontaža sadržaja videoigara. 

Završni rad služi u svrhu upoznavanja čitatelja sa spomenutim zanatom obrađivanja zabavnog 

materijala videoigara putem medija montaže sadržaja videoigara, te razumljivom objašnjavanju 

sposobnosti i tehnika korištenja softvera za grafičko i videouređivanje Magix Vegas Pro 17, uz 

kratke reference na softver Adobe Photoshop, Adobe After Effects i CINEMA 4D, kao i u svrhu 

prikaza samog procesa izrade primjera kompleksne videomontaže materijala specifično 

preuzetog iz svjetski poznate videoigre League of Legends koja pripada tvrtki Riot Games, te 

njezinog izvoza i narednog objavljivanja na web platformu YouTube gdje je njezin sadržaj 

dobrodošao i poželjan. 

Za usvajanje znanja primjenjivanog u završnom radu korišteni su razni lako pronalažljivi web 

resursi, znanstveni radovi i istraživanja relevantnih tema, te službeni vodiči za korištenje 

navedenog softvera najnovijih izdanja. 
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2. Magix - kratka povijest 

Videouređivanje je skupni naziv za sve tehnike i načine manipulacije i reorganizacije 

videomaterijala. Snimanje videa, odnosno filmova, izvorno se u kasnom devetnaestom stoljeću 

sastojalo od jednostavnog postavljanja kamere na odabrano mjesto, te početka snimanja. Uslijed 

toga, sva radnja filma se odvijala u kadru kojega kamera obuhvaća, bez pomicanja kamere. Ono 

što je zapanjivalo publiku je bila čista činjenica kako je uopće moguće snimiti prošle događaje za 

buduće gledanje, tada se to činilo nevjerojatno. [1] 

S vremenom su filmski producenti eksperimentirali s novim tehnikama snimanja, što je kroz 

malo više od stoljeća od osnutka znatno razvilo standarde zanata. Danas, filmove snimaju cijeli 

studiji, u svrhu videouređivanja se zapošljavaju cijele ekipe stručnjaka, a istim zanatom se u 

privatne svrhe može baviti bilo koja osoba s opremom i vremenom za osnovnu obuku. 

Videouređivanje je jedno od najkreativnijih segmenata videoprodukcije te na najvišem nivou 

zahtjeva vrlo tehnički stručnu i maštovitu osobu koja vješto barata filmskom opremom, a s 

razvitkom filmske tehnologije i opreme pojavila se potražnja i za boljim softverom za uređivanje 

videomaterijala. Mnogo poznatih i manje poznatih tvrtki su okušale svoju ruku u dizajniranju 

softvera boljeg od istoga njihove konkurencije, kako Adobe, Sony, ili Blackmagic Design, tako i 

tvrtka Magix 1997. godine sa svojim početnim softwareom Magix Movie Edit Pro, te od 2016. 

godine i sa svojim novije usvojenim softwareom Vegas. [3] 

 

 

 

 

 

 

Magix (ili MAGIX Software) je njemačka programerska tvrtka koja proizvodi softver 

namijenjen videouređivanju, audiouređivanju, DAW (Digital Audio Workstation) softver ili 

softver za slideshow fotografija. [3] Proizvedeni software je namijenjen ne samo privatnom 

amaterskom korištenju, nego je sve popularniji i za korištenje od strane profesionalaca, kao npr. 

grafičkih dizajnera, reklamnih agencija, honoraraca i nezavisnih glazbenih producenata. [4] 

Događaj koji označava osnivanje tvrtke dogodio se 1993. godine kada su se sastali dva 

programera iz tehnološke škole u Dresdenu i dva poduzetnika iz zapadne Njemačke, te na bazi 

algoritma tada postojećeg audio programa Samplitude proizveli svoj prvi vlastiti softver, Music 

Maker - danas jednog od najraširenijih glazbenih softvera u svijetu. [5] 

  

Slika 2.1 Logotip tvrtke Magix 
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Tvrtka Magix je trenutno bazirana u Berlinu, s dodatnim lokacijama kao Madison, Wisconsin 

u SAD-u, Drezden u Saxoniji, Lübbecke u sjevernoj Njemačkoj, te Huizen u Nizozemskoj. [3] 

Tvrtka također ima urede i u Kini, te sveukupno zapošljava više od 350 stručnjaka. [5] Direktor 

tvrtke je Klaus Schmidt. [3] 

Uslijed dolaska na scenu softvera za audiouređivanje 1994. godine Music Maker-om, te 

dolaska na scenu videouređivanja 1997. godine Movie Edit Pro-om, tvrtka Magix 2008. godine 

otvara vlastiti forum „magix.info“ (https://www.magix.info/us/) kao svojevrsan repozitorij 

znanja za stručnjake videouređivanja, audiouređivanja i fotouređivanja. 2016. godine Magix od 

Sony-a iz Sony Creative Software dostupnih produkata preuzima DAW software ACID Pro, 

poznati softver za audiouređivanje Sound Forge, te softver za videouređivanje Movie Studio i 

Vegas Pro. [3] 

 

 

 

Videouređivanje Audiouređivanje Fotouređivanje 

Vegas Pro Music Maker Photo Manager Deluxe 

Video Pro X Sound Forge Photostory Deluxe 

Magix Movie Edit Pro ACID Pro Xara Photo & Graphic Designer 

Vegas Movie Studio Samplitude Page & Layout Designer 

Fastcut Sequoia Designer Pro X 

Video easy  Web Designer 

Tablica 2.1 Proizvodi tvrtke Magix 
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3. Vegas Pro - uvod i sučelje 

Vegas Pro je uveliko nagrađivani softver za videouređivanje nelinearnog tipa sa milijunima 

korisnika diljem svijeta. [6] Prva verzija je napravljena 1999. godine od strane tvrtke Sonic 

Foundry koja je licencu za proizvod prodala tvrtki Sony 2003. godine. Od 2016. godine nadalje 

licenca nad Vegas Pro imenom pripada Magix tvrtki, te je trenutna najnovija verzija softvera 

Vegas Pro 17, sa Vegas Pro 18 u izradi. Softver je pisan u C# i JScript programskim jezicima na 

64-bitnim .NET Framework 4.0 i QuickTime 7 1.6 platformama. [2] 

 

 

 

 

 

 

 

 

 

 

 

Izvorno, Vegas Pro softver osmišljen je u svrhu audiouređivanja, što se promijenilo počevši 

od verzije 2.0 kada je velikom većinom preoblikovan u program za videouređivanje. Dizajniran 

je s jednostavnošću korištenja i pristupačnosti – funkcionira i na slabijim mašinama, bez potrebe 

najnovijeg hardvera. Značajke Vegas Pro softvera uključuju video i audiouređivanje u stvarnom 

vremenu na neograničenom broju vremenskih traka odjednom, podršku za 24-bitnu/192 kHz 

audio i Dolby Digital miješanje, podršku za efekte VST (Virtual Studio Technology)  i DirectX 

priključaka, sekvenciranje videozapisa neovisno o rezoluciji, kontrolu nad Z osi tijekom 

uređivanja kompozicije i pokretne grafike radi simuliranja 3D efekata, podršku za skriptnu 

tehnologiju koja omogućuje automatiziranje zadataka, mogućnosti green screen uređivanja, 

maskiranje grafike u svrhu upravljanja slojevima, keyframe animaciju vizualnih efekata, 

gniježđenje manjih projekata u zajedničku veću kompoziciju, te mnoge druge. [2] 

Vegas Pro softver je korišten u projektima nekoliko pobjednika filmskih festivala, kao i u 

prijenosima velikih televizijskih i radio komentatora, kao Nightline Teda Koppela na 

Američkom televizijskom programu ABC News. [7] Također viđa veliku popularnost sa 

stvarateljima manjeg ranga kao YouTuberima, radi svoje isplativosti unatoč činjenice kako 

sadrži niz visoko konkurentnih mogućnosti, te jednostavnosti sučelja. [2] 

Slika 3.1 Logotip Vegas Pro softvera 
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3.1. Površni pregled sučelja 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sučelje koje korisnik vidi kada pokrene softver naziva se Vegas Pro prozor (eng. Vegas Pro 

Window), te označava mjesto gdje se videouređivanje odvija. [8] Svaki element sučelja se po 

volji korisnika može rastezati i proširivati pritiskom i držanjem na rub prozora elementa te 

vučenjem prema unutra odnosno odvlačenjem prema van, kao i sakriti ili skloniti, ili korištenjem 

Options kartice na alatnoj traci pri vrhu sučelja, ili jednostavnim pritiskom na križić u donjem 

lijevom kutu pojedinog prozora. 

U sklopu sučelja vidljive su tri istaknute regije sa kojima se korisnik prvo suočava: 

 Panel za upravljanje projektom (regija gore lijevo) 

 Prozor za pregled izgleda videa u stvarnom vremenu (regija gore desno) 

 Panel sa vremenskom trakom (donja široka regija) 

3.2. Panel za upravljanje projektom 

Dio sučelja u gornjem lijevom kutu služi za upravljanje videokompozicijom projekta. Ono 

korisniku nudi mnoge upravljačke mogućnosti, osnovne od kojih su dodavanje ili uklanjanje 

elemenata videa iz cjelokupnog projekta umjesto samo iz vremenske trake, dodavanje ili 

uklanjanje mnoštva video efekata i efekata prijelaza na raspolaganju, broj kojih se može 

proširivati vanjskim priključcima na softver, te pregled projekta u cjelini.  

Slika 3.2 Sučelje programa Vegas Pro 17 
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3.2.1. Prozor sa datotekama projekta 

Unutar panela za upravljanje projektom nalazi se prozor sa datotekama projekta (eng. 

Project Media window), te on služi za prikupljanje i organiziranje sveg materijala korištenog u 

kompoziciji korisničkog projekta. Pruža mogućnost dodavanja novog materijala u projekt, 

pregleda istog, promjene svojstava materijala ili dodavanja efekata na materijal izvan sklopa 

vremenske trake projekta. Sklanja se pritiskom na izbornik View > Window > Project Media. [8] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 3.3 sadrži prikaz aktivnog panela za upravljanje projektom sa trenutno fokusiranim 

Project Media prozorom; primjer kakav bi isti mogao izgledati tijekom procesa korisnikovog 

videouređivanja. Ružičastom strelicom i povezanim obrubom označene su kontrole za navigaciju 

po pojedinim prozorima panela za upravljanje projektom. 

U sklopu prozora s datotekama projekta, crvenom strelicom i povezanim obrubom označeni 

su trenutno korišteni video i audioelementi. Trenutno inspektirani element na kojega je korisnik 

posljednjeg kliknuo istaknut je svijetlo plavom bojom. Tamno plavom strelicom i povezanim 

obrubom označene su od strane softvera automatske generirane projektne mape koje korisnik 

svojevoljno može koristiti za bolju organizaciju i preglednost projekta. Preporučeno je ovu 

mogućnost koristiti tijekom izrade vrlo opširne montaže videomaterijala. Ukoliko je bilo koja od 

datoteka projekta označena klikom miša, pojavit će se informativni okvir označen zelenom 

strelicom i povezanim obrubom. U njemu korisnik pronalazi osnovne informacije o video i 

audiospecifikacijama elementa, kao rezoluciju videa, brzinu, trajanje, kvalitetu, raspon audia, te 

informacije o formatima.  

Slika 3.3 Prozor sa datotekama projekta 
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3.2.2. Prozor za pretraživanje 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pokraj prozora s datotekama projekta nalazi se prozor za pretraživanje (eng. Explorer 

window, slika 3.4), koji postoji kako bi olakšao pretraživanje tvrdoga diska korisnika u potrazi 

za željenim grafičkim ili audiomaterijalom koji se nakon pronalaska iz prozora može dodati u 

korisnikov projekt, dokle god je format istog podržan od strane programa. Standardno je uvijek 

uključen, a sklanja se pritiskom na izbornik View > Window > Explorer, ili pritiskom kratice 

gumba Alt + 1 na tastaturi. 

3.2.3. Prozor s efektima prijelaza 

Odmah desno od prozora za pretraživanje nalazi se prozor sa efektima prijelaza (eng. 

Transitions window, slika 3.5). Prozor Transitions sadrži sve korisniku trenutno dostupne efekte 

prijelaza i njihove varijacije. Svaki efekt se prije korištenja može pregledavati (korisniku se 

automatski pokrene animirani primjer efekta kada postavi pokazivač miša na željeni efekt) i 

modificirati, s mogućnošću spremanja svakih pojedinih željenih varijacija postavki efekta u 

svrhu lakšeg budućeg korištenja. Na lijevoj strani prozora nalazi se dio koji služi za pretraživanje 

spomenutih efekata. Svaki dostupni efekt je standardno organiziran u mape automatski 

generirane od strane softvera radi što lakše navigacije, pri čemu su svi efekti dodani u program 

putem vanjskih priključaka posebno izdvojeni u jednu zajedničku mapu nazvanu Third Party. Pri 

vrhu spomenutog dijela za pretraživanje nalazi se tražilica ključnih riječi za dodatno olakšanu 

pretragu. [8]  

Slika 3.4 Prozor za pretraživanje 
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Prozor sa efektima prijelaza je standardno uvijek uključen, a sklanja se pritiskom na izbornik 

View > Window > Transitions, ili pritiskom kratice gumba Alt + 7 na tastaturi. [8] 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.4. Prozor s videoefektima 

Pokraj prozora s efektima prijelaza nalazi se prozor s videoefektima (eng. Video FX 

(Effects) window), slika 3.6. Prozor Video FX sadrži sve korisniku trenutno dostupne vizualne 

efekte za dodatno uređivanje i personalizaciju montaže po volji. Isto kao i s efektima prijelaza, 

svaki vizualni efekt se prije korištenja može pregledavati, modificirati, te ima mogućnosti 

spremanja varijacija postavki. Videoefekti uključuju efekte korekcije boja na videomaterijalu po 

želji, maskiranja dijelova videomaterijala, modifikacije kontrasta i svjetline, uređivanja 

zasićenosti i čistoće slike, kao i mnoštvo različitih specijalnih efekata. Na lijevoj strani prozora 

se ponovno nalazi dio za pretraživanje spomenutih vizualnih efekata, efekti su ponovno 

standardno organizirani u mape automatski generirane od strane softvera, te je opet izdvojena 

Third Party mapa. Pri vrhu dijela za pretraživanje vizualnih efekata nalazi se tražilica ključnih 

riječi za dodatno olakšanu pretragu. Za razliku od efekta prijelaza, vizualni efekti se mogu 

dodavati ne samo na kraj ili početak jednog od videoelementa, već i aktivno na element u cjelini, 

ili cijelu vremensku traku koja sadrži niz elemenata kako bi se efekt primijenio na cijeli niz 

elemenata u traci odjednom. Prozor sa videoefektima je standardno uvijek uključen, a sklanja se 

pritiskom na izbornik View > Window > Video FX, ili pritiskom kratice gumba Alt + 8 na 

tastaturi. [8] 

  

Slika 3.5 Prozor sa efektima prijelaza 



10 

 

 

 

 

 

 

 

 

 

3.2.5. Prozor s generatorima elemenata 

Odmah desno od prozora s videoefektima nalazi se prozor s generatorima elemenata (eng. 

Media Generators window), slika 3.7. Prozor Media Generators služi za dodavanje jednostavnih 

programsko generiranih elemenata u videokompoziciju po potrebi. Generirani elementi bez 

dodatnih softverskih priključaka uključuju uzorke gradijenata i blokova boja, uzorke tekstualnih 

stilova, uzorke za testiranje boja, uzorke tekstura zvuka, simulirane šahovnice i primjerke 

pozadina, te se svaki element može dodatno modificirati po želji korisnika prije ili nakon 

dodavanja na vremensku traku. Na lijevoj strani prozora se ponovno nalazi dio za pretraživanje 

svih uzoraka elemenata dostupnih na izbor. Prozor sa generatorima elemenata je standardno 

uvijek uključen, a sklanja se pritiskom na izbornik View > Window > Media Generators, ili 

pritiskom kratice gumba Alt + 9 na tastaturi. [8] 

 

 

 

 

 

 

 

 

 

  

Slika 3.6 Prozor s videoefektima 

Slika 3.7 Prozor s generatorima elemenata 
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3.3. Prozor za pregled izgleda videa 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dio sučelja u gornjem desnom kutu naziva se prozor za pregled izgleda videa (eng. Video 

Preview window), slika 3.8. Prozor za pregled izgleda videa sadrži videopreglednik pomoću 

kojeg korisnik dobiva mogućnost pregledavanja uratka u stvarnom vremenu tijekom uređivanja, 

prije konačnog izvoza, te tijekom samog izvoza projekta. Pri vrhu prozora nalaze se gumbi za 

podešavanje rezolucije i kvalitete aktivnog pregleda, kao i opcija brzog spremanja slike koja se u 

trenutnu klika nalazi na zaslonu preglednika u punoj rezoluciji na radnu površinu, ukoliko je 

potrebno detaljno pregledavanje boja ili naknadno uređivanje slike. Pri dnu prozora nalaze se 

gumbi za kontrolu reprodukcije pregleda, kao pauziranje, zaustavljanje, premotavanje videa, plus 

dva dodatna gumba koja pomiču vremensku točku u videu za točno jednu sličicu u svrhu vrlo 

precizne kontrole pregleda. Ispod gumbi za reprodukciju nalazi se okvir u kojemu su ispisane 

informacije o videu kojeg preglednik reproducira, kao brzina izmjena slika u videu, rezolucija, 

redni broj trenutno prikazivane slike, te veličina prozora preglednika. Prozor za pregled izgleda 

videa je standardno uvijek uključen, a sklanja se pritiskom na izbornik View > Window > Video 

Preview, ili pritiskom kratice gumba Alt + 4 na tastaturi. [8] 

Slika 3.8 Prozor za pregled izgleda videa u stvarnom vremenu 
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3.4. Panel s vremenskom trakom 

Dio sučelja koji zauzima područje ispod ostalih panela naziva se panel s vremenskom 

trakom (eng. Timeline), slika 3.9. Vremenska traka predstavlja „glavni“ dio Vegas Pro softvera 

na kojem se nalaze svi aktivni video i audioelementi i ujedno je mjesto gdje korisnik obavlja 

većinu montaže. Slika 3.9 sadrži prikaz aktivnog panela s vremenskom trakom; primjer kakav bi 

isti mogao izgledati tijekom procesa korisnikovog videouređivanja. Crvenom strelicom označena 

je prva traka kompozicije, koja sa najvišom pozicijom na panelu ujedno drži i najviši sloj - 

elementi koje sadrži vizualno se nalaze ispred elemenata svih drugih traka. Jedina je aktivna 

videotraka u kompoziciji jer je jedina videotraka koja sadrži elemente. Tamno plavom strelicom 

označena je druga traka kompozicije koja je ujedno jedina aktivna audiotraka u kompoziciji. 

Audiotrake nemaju vrijednosti slojeva jer zvuk nema vizualnu vrijednost na ekranu. Ružičastom 

strelicom označena je treća traka koja je jednako podešena videotraka kao i prva traka 

kompozicije osim po poretku i činjenici da je treća traka prazna i neaktivna, bez elemenata. 

Zelenom strelicom označena je četvrta traka koja je jednako podešena audiotraka kao i druga 

traka kompozicije osim po poretku i činjenici da je četvrta traka prazna i neaktivna, bez 

elemenata. Žutom strelicom označen je prazan prostor kojeg mogu popuniti dodatne trake 

ukoliko korisniku budu potrebne. 

Ispod svih traka nalazi se prostor koji sadrži gumbe za reprodukciju i označavanje željenih 

vremenskih točki na panelu vremenske trake. U gornjem lijevom kutu panela nalazi se 

vremenska oznaka koja korisniku daje preciznu informaciju o vremenskoj točki na kojoj je 

zaustavljen upravljač vremenske trake. Na lijevom kraju svake aktivne i neaktivne trake nalazi se 

odlomak s postavkama pojedine trake. Svaka traka se može proizvoljno obojati radi bolje 

organizacije radnog prostora desnim klikom na lijevi kut trake, te odabirom željene boje pod 

Track Display Color opcijom. Prozor za pregled izgleda videa je standardno uvijek uključen i 

nemoguće ga je isključiti. [8] 

 

 

 

 

 

 

 

 

  
Slika 3.9 Panel sa vremenskom trakom 
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4. Proces montaže 

Montaža je naziv za postupak odabiranja i povezivanja kadrova, spajanja nastalih sekvenci i 

naposljetku stvaranja cjelovitog videouratka. [9] Uključuje cjelokupni proces videouređivanja i 

može joj se pristupiti ukoliko je korisnik svladao osnove softvera namijenjenog za uređivanje. 

4.1. Ubacivanje video i audioelemenata u projekt 

Svaki proces montaže započinje prikupljanjem video i audiomaterijala kojeg će korisnik 

upotrebljavati, te unošenje istoga u softver za videouređivanje. Magix Vegas Pro 17 softver ima 

tri glavna načina unošenja (eng. Importing) filmskog materijala: 

 „Drag and drop“ način - korisnik željeni materijal pokazivačem miša prenosi sa radne 

površine ili iz mape u kojoj se nalazi materijal direktno na panel s vremenskom trakom 

softvera, pri čemu softver automatski generira elemente vremenske trake koji odgovaraju 

upravo unesenom materijalu. 

 File > Import > Media naredba (slika 4.1) - korisnik unosi željeni materijal u 

kompoziciju putem naredbe iz glavne alatne trake, prilikom čega se otvara novi prozor za 

pretraživanje i pronalaženje spomenutog materijala na tvrdom disku. 

 

 

 

 

 

 

 

 

 

 

 

 

 Putem prozora za pretraživanje - korisnik koristi prozor za pretraživanje (eng. 

Explorer window) unutar panela za upravljanje projektom kako bi pronašao željeni 

materijal na tvrdom disku i unio ga na vremensku traku. 

Slika 4.1 Korištenje File > Import > Media naredbe 
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Prilikom unošenja videomaterijala u softver korisnik se ponekad može susresti s greškom 

„An error occured while opening one or more files. The file is most likely corrupted or of an 

unknown format.“, u prijevodu „Dogodila se greška s otvaranjem jedne ili više datoteka. 

Datoteka u pitanju je najvjerojatnije pokvarena ili nepoznatoga formata“ (slika 4.2). 

Spomenuta greška se standardno pojavljuje ukoliko korisnik pokušava za uređivanje unijeti 

datoteku koja je softveru nepoznatoga formata ili datoteku koja je oštećena u prijenosu, no 

ponekad se isto dogodi i s poznatim, iako zastarjelim videoformatima, kao AVI (Audio Video 

Interleave) formatom, ukoliko korisnik koristi inačicu Windows-a 10. Spomenuti operativni 

sustav često ne dolazi sa podržanim kodecima za AVI format, te ih je korisnik obavezan 

instalirati prije korištenja željenog videomaterijala spomenutog formata. 

 

 

 

 

 

 

 

 

 

 

 

U svijetu uređivanja zabavnoga materijala videoigri tijekom prošlog desetljeća u svrhu 

snimanja i spremanja filmske materije videoigre često i popularno koristio se softver Fraps. 

Fraps je danas zastarjeli softver koji korisnicima omogućava bilježenje njihovih najdražih 

trenutaka igranja videoigara isključivo u AVI formatu, no sa mogućnošću širokog i oslobođenog 

podešavanja specifikacija filmske datoteke koja će biti spremljena na odabranom mjestu na 

tvrdom disku korisnika uoči obustave snimanja, čak i do razina dubljih nego što je većina 

današnjeg modernijeg softvera, kao npr. GeForce Experience, sposobna dosegnuti radi limitacija 

formata snimanja. Fraps softver dolazi sa vlastitim FPS1 AVI kodekom, čija je integracija 

obavezna ukoliko korisnik inzistira na korištenju videomaterijala snimljenog koristeći Fraps 

softver. Jedini način integracije FPS1 AVI kodeka jest instalacija Fraps softvera na računalo. 

[10] 

 

 

  

Slika 4.2 Greška pri unosu videomaterijala - nepodržani format 
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4.2. Uređivanje trajanja elemenata projekta 

Nakon što se željeni element unese na vremensku traku, preporučljivo je prvenstveno urediti 

vremensku poziciju i trajanje istog. Svaki videoelement s priključenim audiom uslijed unosa na 

vremensku traku Vegas Pro softvera poprima grafičku reprezentaciju prikazanu na slici 4.3. 

 

 

 

 

 

 

 

 

Iznad elementa nalazi se vremenska skala (eng. Ruler) iz kojeg se može iščitati trenutno 

trajanje elementa. Element na slici 4.3 ima trajanje od petnaest sekundi. Pritiskom na bilo koji 

kraj elementa i guranjem miša prema unutrašnjosti elementa, korisnik dobiva mogućnost 

polaganog skraćivanja trajanja elementa počevši iz kraja na kojeg se pritisnulo (skraćivati će se 

početak elementa ako se klikne i vuče s lijevoga kraja prema desno, odnosno skraćivati će se kraj 

elementa ako se klikne i vuče s desnoga kraja prema lijevo). Suprotno, ukoliko korisnik pritisne 

na kraj elementa te vuče miš s kraja prema van (npr. pritisne na desni kraj elementa i vuče miš 

prema desno), element će se produžavati. Ukoliko se element na vremenskoj traci produžuje, ali 

izvornom filmskom materijalu kojega reprezentira ponestane vremenskog sadržaja s kojim bi se 

podržalo spomenuto produživanje, početak elementa će se početi pridodavati na kraj rezultirajući 

u vremenskom ponavljanju filmskom materijala. Ukoliko je potrebno smanjiti ili povećati 

trajanje nekog elementa no pri tome zadržati vremensko trajanje jednako trenutnom istog, 

korisnik ima priliku koristiti mogućnost utjecanja na brzinu reprodukcije elementa (koristiti 

slow, odnosno fast motion). Kako bi se ovo postiglo, korisnik treba pritisnuti i vući jedan od 

krajeva videa, no ovaj put pri tome držati pritisnuta tipku Control na tastaturi. Ovim postupkom 

korisnik, ukoliko vuče prema unutrašnjosti elementa, smanjuje trajanje videa i audia dok njihov 

sadržaj ostaje cjelovit, odnosno ubrzava reprodukciju elementa (naređuje element u fast motion), 

ili suprotno ukoliko vuče suprotno od unutrašnjosti elementa, povećava trajanje videa i audia dok 

njihov sadržaj ostaje cjelovit, odnosno usporava reprodukciju elementa (naređuje element u slow 

motion). 

U trenutnoj inačici, Magix Vegas Pro 17 podržava maximalno četverostruki slow, odnosno 

fast motion prije potrebe izvoza videa u svrhu dodatnog usporavanja ili ubrzavanja. 

Slika 4.3 Uobičajeni izgled filmskog elementa na vremenskoj traci 
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Prilikom unosa elemenata na vremensku traku ponekad se dogodi situacija da video filmskog 

materijala nije jednakog vremenskog trajanja kao i njemu povezani audio. Korisnik može izvršiti 

provjeru za ovakvim pogreškama pri unosu pozicioniranjem vremenskog pokazivača na desni 

kraj unesenog elementa, te približavanja pregleda vremenske trake (eng. Zoom) na razinu slika, 

odnosno standardno jedne šezdesetine sekunde, korištenjem kotača miša dok drži pritisnut gumb 

Alt na tastaturi. Ukoliko prilikom provjere korisnik uoči kako se dogodila spomenuta situacija, 

preporučljivo je izjednačiti trajanje pojedinih segmenata ručnim skraćivanjem trajanja dužeg 

elementa ili korištenjem funkcije rezanja elemenata (eng. Split) te uklanjanja viška radi lakše 

buduće kontrole projekta. Naredba Split se koristi odabirom elementa kojega se želi rezati, 

pozicioniranjem vremenskog pokazivača na vremensku točku u kojoj korisnik želi kreirati rez, te 

pretiskom gumba S na tastaturi, nakon čega će se element razdvojiti u dva dijela u odabranoj 

vremenskoj točki (slika 4.4 i slika 4.5). Naredba Split također ujedno reže i sve elemente koji su 

grupirani s odabranim elementom neovisno o video ili audiotraci u kojoj se isti nalaze, ukoliko 

se oni također protežu kroz odabranu vremensku točku za rezanje. Ukoliko korisnik ne odabere 

element koji želi rezati prije primjene naredbe Split, korištenje naredbe će kreirati rez u svim 

elementima koji se protežu kroz odabranu vremensku točku za rezanje, neovisno o video ili 

audiotraci u kojoj se isti nalaze, i neovisno o grupacijama s drugim elementima kompozicije 

projekta. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Slika 4.4 Ispravljanje nejednakog elementa prije primjene funkcije rezanja 

Slika 4.5 Ispravljanje nejednakog elementa nakon primjene funkcije rezanja 
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U svijetu uređivanja zabavnog materijala videigri postoji posebna tehnika snimanja za 

povećanje opće kvalitete snimki koja koristi dodatno podešavanje unutar sklopa videoigre čiji 

sadržaj korisnik namjerava snimati. Tehnika je uglavnom korištena u svrhu omogućavanja 

kvalitetne tečnosti snimke čak i na korisničkim mašinama loših specifikacija, no dostupna je i 

korisnicima s modernijom opremom u svrhu postizanja iznimno kvalitetnih razina tečnosti 

videomaterijala koje inače nisu moguće. 

 

 

 

 

 

 

Pošto softver za videouređivanje, poput Vegas Pro 17, ima mogućnost ubrzavanja ili 

usporavanja brzine reprodukcije videomaterijala, moguće je, ukoliko videoigra koju korisnik želi 

snimati to dopušta, unutar sklopa videoigre prije početka snimanja usporiti reprodukciju 

razvijanja sadržaja za određenu veličinu. Ukoliko se tada softverom za snimanje zanimljivih 

trenutaka videoigara započne snimanje sadržaja, spremljeni video prilikom završetka snimanja 

će se sastojati od snimke usporenog razvijanja sadržaja videoigre, koja se naposljetku u softveru 

za videouređivanje može naknadno ubrzati na stvarnu, originalnu brzinu reprodukcije. Ukoliko 

korisnik koristi spomenutu tehniku snimanja, filmski materijal koji namjerava uređivati će imati 

iznimno tečnu snimku, neovisno o snazi korisnikove mašine, koja neće gubiti kvalitetu tečnosti 

pojedinih slika (eng. Frames) ni u slučaju da korisnik podesi videomaterijal na stanje usporene 

reprodukcije u montaži (slika 4.6). Mana tehnike je u tome što se u slučaju korištenja tehnike 

audio udio sadržaja videoigre mora naknadno snimati i usklađivati sa video udiom, jer će u 

sklopu snimke usporenog razvijanja sadržaja videoigre audio biti nerazumljiv. Preporučeno je 

filmski materijal naknadno usklađen spomenutim načinom uslijed usklađivanja također i 

grupirati (eng. Group) u sklopu softvera Vegas Pro 17 radi lakšeg uređivanja, što se standardno 

izvršava pritiskom na gumb G na tastaturi korisnika, ili pritiskom na izbornik Edit > Group > 

Create New nakon selektiranja dvaju ili više negrupiranih elemenata. [8]  

  

Slika 4.6 Grupa usklađenih elemenata snimljenih nakon usporavanja videoigre 
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4.3. Organizacija elemenata projekta i osmišljavanje vizije projekta 

Kada korisnik unese sav videomaterijal u kompoziciju, te pravilno uredi elemente radi lakšeg 

korištenja istih, nastupa korak organizacije spomenutih elemenata i uspostavljanja glavnih ideja 

konačnog izgleda projekta. 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.7 prikazuje izgled kompozicije projekta završnog rada u trenutnom koraku izrade, kao 

primjer izgleda kompozicije projekta u koji je potpuno unesen videomaterijal kojega korisnik 

namjerava koristiti, uključujući grešku: vidljivo je kako je glasnoća zvuka elemenata na kraju 

vremenske trake puno veća nego glasnoća zvuka elemenata na početku vremenske trake. 

Korisnik može ispraviti ovu pogrešku smanjivanjem razina zvuka glasnijih elemenata klikom na 

vrh grafike audioelementa u pitanju te povlačenjem pokazivača prema dolje, dok razina zvuka 

nije izjednačena s razinom zvuka tiših elemenata. Ukoliko spomenuta procedura učini 

kompoziciju pretihom, korisnik ima mogućnost povećavanja glasnoće cijele audiotrake na kojoj 

se nalaze elementi pomoću klizača koji se nalazi među stavkama trake. 

Ukoliko su sve greške ispravljene, sljedeći korak montaže ovisi o korisniku. Montiranje 

zabavnog materijala je većim udjelom umjetnički proces, te je jedino stvarno ograničenje mašta 

korisnika. Korisnik je dužan osmisliti viziju projekta, isplanirati tijek rada kojim će ostvariti 

spomenutu viziju, te odrediti konačno trajanje projekta. U svijetu uređivanja montaža videoigri, 

montaže se uvijek izrađuju uključujući zvučnu potporu u obliku glazbe, te je preporučeno 

odrediti trajanje montaže slično trajanju priložene glazbe, kako bi se izbjegli periodi tišine u 

videouratku koji bi mogli narušiti zainteresiranost gledatelja.  

Slika 4.7 Projekt sa potpuno unesenim videomaterijalom 
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Glazbeni uraci korišteni u montažama videoigara su pretežito društveno popularni i 

prepoznatljivi, najčešće u trajanju od dvije do šest minuta. Ukoliko se korisnik namjerava 

profesionalno baviti montažom sadržaja videoigara, potrebno je obavezno obratiti pozornost na 

autorska prava umjetnika pri odabiru željene glazbe. Držeći se tog pravila, u projektu završnog 

rada korišten je glazbeni primjerak „Memories“ umjetnika Dracz koji je za spomenuto korištenje 

osobno dao suglasnost. Korisnik ima mogućnost korištenja više glazbenih primjeraka u projektu 

ukoliko vjeruje kako isto neće narušiti pozornosti gledatelja radi neujednačenosti i potencijalno 

predugog trajanja montaže. Ukoliko je korisnik priredio vremenski mnogo više videomaterijala 

nego je moguće uklopiti u trajanje glazbe, preporučljivo je izolirati najpoželjniji i 

najinteresantniji videomaterijal te u montaži koristiti samo izolirani. Na vremenskoj traci, u 

svrhu odabira, označavanja i dodatne ogranizacije, korisnik ima mogućnost koristiti se funkcijom 

oznake (eng. Mark) koja se primjenjuje pozicioniranjem vremenskog pokazivača na vremensku 

točku u kojoj želi ostaviti oznaku, te pritiskom na gumb M na tastaturi. Prilikom primjene, na 

vremenskoj traci će se generirati narančasta oznaka koju je moguće proizvoljno imenovati, te 

koja se proteže kroz sve video i audiotrake kompozicije (slika 4.8). 

 

 

 

 

 

 

 

 

 

 

 

Vremenski poredak videomaterijala u montaži videoigre nikada nije slučajan, već se određuje 

ovisno o nekoliko osnovnih pravila. Početni i krajnji trenuci montaže su najvažniji, te je 

preporučeno najinteresantniji videomaterijal rezervirati za predviđeni početak i kraj trajanja 

projekta na vremenskoj traci, a ostali zanimljivi videomaterijal postaviti na dropove priložene 

glazbe (eng. drop u glazbenom uratku je trenutak početka najintenzivnijeg dijela glazbe, najčešće 

refrena uratka), u svrhu komplimentiranja snage utjecaja videouratka na gledatelja i pobuđenja 

osjećaja oduševljenosti u gledatelju. Poseban značaj i pažnju zahtijevaju dropovi koji se u 

glazbenom uratku nalaze pri početku ili kraju trajanja uratka.  

Slika 4.8 „Oznaka #1“ na vremenskoj traci 
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Radi olakšanog procesa spomenutog postavljanja zanimljivog videomaterijala na dropove i 

ostale ključne točke priključenog glazbenog uratka, korisniku je preporučeno i u ovu svrhu 

koristiti funkciju oznake ukoliko je korisnik odredio konačnu poziciju elementa uratka glazbe na 

vremenskoj traci, kako je vidljivo na slici 4.9 koja prikazuje uporabu spomenute funkcije na 

kompoziciji projekta završnog rada. 

 

 

 

 

 

 

 

 

 

 

 

 

Uoči zaključivanja ideje i narednog završetka organizacije elemenata, korisnik stvara urednu 

kompoziciju projekta. Primjer kompozicije projekta završnog rada vidljiv je na slici 4.10. 

Elementi su idealno poslagani po željama korisnika, usko uklopljeni u vrijeme trajanja 

priključene glazbe, te uredno označeni i spojeni jedan u drugi. Korisnik ima mogućnost kreiranja 

dodatnih video i audiotraka u svrhu izražavanja svojstva slojevitosti videomaterijala koje softver 

pruža, ili u svrhu kreiranja scene koja sadrži varijante suženih dimenzija od više različitih 

primjeraka videomaterijala u isto vrijeme. Radi bolje preglednosti, korisnik proizvoljno može 

odabrati smanjenje veličine grafičke reprezentacije određenih rjeđe korištenih video i audiotraka 

elemenata klikom na gumb Više (eng. More) koji se nalazi u području koje sadrži stavke 

pojedinih traka i označen je ikonom koja sadrži tri vodoravne bijele crte, te odabirom funkcije 

Smanji (eng. Minimize). 

 

 

 

 

 

 

  

Slika 4.9 Korištenje funkcije oznake u svrhu bilježenja ključnih glazbenih trenutaka 

Slika 4.10 Primjer završenog koraka organizacije elemenata 
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4.4. Funkcija Event Pan/Crop i dodavanje efekata na elemente 

U gornjem desnom kutu vizualne reprezentacije svakog videoelementa unesenog u video 

trake na vremenskoj traci nalaze se dva gumba prikazana na slici 4.11. 

 

 

 

 

 

 

 

 

Pristiskom na desni gumb, nazvan Efekti Elementa (eng. Event Effects) ili Event FX gumb, 

korisniku se otvara meni za upravljanje svih videoefekata trenutno korištenih na videoelementu u 

pitanju. Gumb Event FX postoji i na audioelementima, jer je i na audioelemente moguće 

dodavati određene audioefekte. Ukoliko je element trenutno bez priključenih dodatnih efekata, 

gumb Event FX je standardno sivo obojan. Ukoliko se na element priključe bilo kakvi efekti, 

gumb Event FX poprima zelenu boju kako bi se korisniku efikasnije dostavile važne i potrebne 

informacije pri uređivanju kompozicije projekta. 

Pritiskom na lijevi gumb, nazvan Pomicanje/Obrezivanje Elementa (eng. Event Pan/Crop), 

koji je dostupan isključivo kod videomaterijala, korisniku se otvara prozor s geometrijskim 

postavkama elementa u pitanju prikazan na slici 4.12.  

 

 

 

 

 

 

 

 

 

 

  

Slika 4.11 Event Pan/Crop i Event FX gumbi 

Slika 4.12 Event Pan/Crop prozor 
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Koristeći se Event Pan/Crop prozorom, korisnik može utjecati na geometriju videoelementa 

kojega uređuje. Na lijevom dijelu prozora nalaze se postavke rezolucije elementa, njegove 

horizontalne i vertikalne točke centriranja u radnom prostoru, kuta nakrivljenosti i pozicije sa 

koje spomenuti kut utječe na cjelokupni izgled elementa, te razine približavanja pogleda (eng. 

zoom) ukoliko korisnik želi obratiti pažnju na sitniji detalj unutar videoelementa. Pri dnu prozora 

korisniku je omogućena vremenska traka koja bilježi promjene u geometriji specifično trenutno 

otvorenog elementa u stanju uređivanja, ne videa u cjelini, te služi za pomoć pri uređivanju ili u 

svrhu animiranja elementa u prostoru kroz vrijeme. Iznad vremenske trake i desno od 

geometrijskih postavki se nalazi najveći dio menija koji predstavlja i prekazuje trenutni prikaz 

elementa kojega korisnik aktivno uređuje u prostoru. Pritiskom desnog klika miša na spomenuti 

dio menija korisniku se otvara padajući pod-meni preko kojega ima mogućnost provoditi 

jednostavnije promjene na položaj elementa, horizontalno ili vertikalno zrcaljenje elementa i 

centriranje elementa u vidokrugu. 

Dodavanje videoefekata u Magix Vegas Pro 17 softveru vrši se pronalaženjem željenog 

efekta unutar prozora s videoefektima u sklopu panela za upravljanje projektom, te ručnog 

izvlačenja spomenutog na videoelement ili videotraku na koju korisnik želi dodati efekt. Uoči 

puštanja klika miša nad uređivanim elementom ili trakom, korisniku se pojavljuje novi prozor 

prikazan u primjeru na slici 4.13 pomoću kojega je moguće animirati i podešavati postavke 

korištenog efekta po volji. Pri završetku izmjena postavki, korisnik zatvara novootvoreni prozor, 

nakon čega je željeni efekt uspješno aktiviran. Korisnik ima mogućnost izmjenjivanja 

spomenutih postavki pritiskom na Event FX gumb uređivanog elementa ili trake. 

 

 

 

 

 

 

 

 

 

 

 

  

Slika 4.13 Prozor sa postavkama efekta linearnog zamagljivanja 
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4.5. Stvaranje dodatne ukrasne grafike u softveru Adobe Photoshop 

Adobe Photoshop je softver za uređivanje rasterske grafike, originalno napravljen 1998. 

godine, te je od tada postao industrijski standard ne samo u svrhu uređivanja rasterske grafike, 

već i u svrhu cjelokupnog kreiranja oblika digitalne umjetnosti. Softver je od osnivanja dostigao 

razinu popularnosti da je „fotošopiranje“ postalo kolokvijalno prihvaćeni i razumljivi izraz 

diljem cijelog svijeta grafičke umjetnosti i tehnologije. [11] 

Koristeći softver Adobe Photoshop korisnik ima mogućnost kreiranja grafike u obliku 

prekrivača (eng. overlay graphics) kao dodatni efekt i radi daljnje personalizacije projekta. U 

svijetu montaža videoigara, overlay grafika je često kreirana i u svrhu ostavljanja vlastite oznake 

ili potpisa stvaratelja na izrađivanu montažu, što je krucijalno kao sredstvo protiv plagijata. 

Overlay grafika se unutar softvera Photoshop izrađuje i sprema s transparentnom pozadinom, 

kako bi se unutar Vegas Pro 17 softvera mogla koristiti iznad videomaterijala putem svojstva 

slojevitosti videotraka. Uz mirujuće slike, korisnik putem softvera Photoshop također ima 

mogućnost stvaranja jednostavnijih animacija ukoliko se iste nakon izrade spreme kao slijed 

slika (eng. image sequence) čiji format softver Vegas Pro 17 podržava. Dok je činjenica kako se 

overlay grafika može izrađivati s namjerom prekrivanja cijele scene, preporučeno je izrađivati 

istu s namjerom zauzimanja pretežno samo kutove scene, kako grafika nebi ometala gledateljevo 

promatranje videomaterijala kojega ukrašava. Overlay grafika koja je korištena u projektu 

završnog rada, izrađena u softveru Adobe Photoshop u svrhu istovremenog ukrašavanja i 

personalizacije scene uz svojevrsno potpisivanje stvaratelja na uradak, prikazana je na slici 4.14. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Slika 4.14 Primjer overlay grafike izrađene u softveru Adobe Photoshop 
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4.6. Stvaranje dodatnih efekata u softveru Adobe After Effects 

Adobe After Effects je softver za stvaranje digitalnih vizualnih efekata, pokretne grafike i 

kompozitnih uradaka korišten u procesu postprodukcije filmova, videoigara, i televizijske 

produkcije u svrhu komponiranja i grafičke animacije svih oblika. Softver je originalno 

napravljen 1993. godine te je od tada korišten od strane milijuna stručnjaka diljem svijeta. 2019. 

godine softver Adobe After Effects je osvojio akademsku nagradu za znanstveno i tehničko 

postignuće radi doprinosa napretku filmske industrije. [12] 

Unutar Adobe After Effects softvera korisnik ima priliku izraditi napredne vizualne i 

audioefekte u svrhu daljnje personalizacije i ukrašavanja svojih projekata. Softver sam po sebi 

sadrži tisuće efekata na raspolaganju, svaki od kojih se može iznimno detaljno modificirati po 

želji korisnika. Dostupni efekti uključuju i trodimenzionalne simulacije čestica ili objekata 

generirane od strane softvera i daljnje oblikovane korisnikovim doprinosom, kao i mogućnost 

animacije istih na vremenskoj traci u svrhu realizacije scene koju korisnik želi ostvariti, bez 

obzira na razinu kompliciranosti. Generirane čestice i ostali efekti se mogu povezati sa 

glazbenim uratkom tako da reagiraju na intenzitet glazbe pokretima ili sastavnim promjenama 

određenim od strane korisnika. Pri završetku animacije, softver Adobe After Effects podržava 

izvoz generirane grafike u obliku slijeda slika s transparentnom pozadinom, kojeg korisnik zatim 

ima mogućnost koristiti u softveru za videouređivanje poput Magix Vegas Pro 17 kao dodatnu 

overlay grafiku. U svijetu montaža zabavnog materijala videoigara, najklasičniji i najkorišteniji 

oblik overlay grafike generiran u softveru Adobe After Effects koji reagira na intenzitet glazbe je 

audio spektar (eng. audio spectrum). Primjer izrade audio spektra koji je nakon izrade korišten 

u projektu završnog rada prikazan je na slici 4.15. 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.15 Primjer izrade audio spektra u softveru Adobe After Effects 
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4.7. Stvaranje dodatnih efekata u softveru CINEMA 4D 

CINEMA 4D je softver za stvaranje trodimenzionalne grafike, modela i efekata u svrhu 

korištenja u filmskoj industriji i industriji videoigara. Softver je inicijalno napravljen ranih 1990-

tih godina, te je danas jedan od glavnih konkurentnih softvera Autodesk-ovom softveru Maya. 

[13]  

Koristeći softver CINEMA 4D korisnik ima mogućnost spajanja svijeta videouređivanja sa 

svijetom trodimenzionalnog modeliranja i animacije kao dodatnog načina personalizacije svoga 

uratka. Softver CINEMA 4D omogućuje generiranje i uređivanje već postojećih ili proizvoljno 

naknadno napravljenih animacija s trodimenzionalnim modelima korisnikovih najdražih likova 

izvučenih direktno iz videoigre koju korisnik namjera koristiti kao temelj svoje zabavne 

montaže. Korisnik ima mogućnost reteksturiranja modela u pitanju po volji, kao i bojanja i 

dodavanja vizualnih efekata na spomenute trodimenzionalne modele. Po završetku rada i 

postizanja željenog rezultata, korisnik ima mogućnost izvesti uradak u obliku slijeda slika sa 

transparentnom pozadinom u formatu podržanom od strane softvera za videouređivanje poput 

Vegas Pro 17 u svrhu korištenja u montažama zabavnog materijala videoigara ili dodatnog 

uređivanja. Primjer procesa uređivanja animacije trodimenzionalnog modela lika preuzetog iz 

videoigre League of Legends, koja je korištena u projektu završnog rada, prikazan je na slici 

4.16. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Slika 4.16 Animacija trodimenzionalnog modela lika u softveru CINEMA 4D 
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4.8. Izvoženje finalizirane montaže u filmsku datoteku 

Prilikom završetka video i audiouređivanja svoje montaže zabavnog materijala videoigre, 

korisnik je dužan uradak izvesti iz softvera Vegas Pro 17 u filmskom formatu podržanom od 

strane web destinacije na koju montažu želi objaviti. Postavke pri izvozu uratka su brojne, te 

korisnik mora odabrati format ovisno o željenoj veličini datoteke koju će izvoz generirati, o 

željenoj video i audiokvaliteti, maksimalnoj brzini prijenosa, dozvoljenom vremenu izvoza 

ukoliko postoji rok za isto, te namjeri budućeg korištenja. Softver Magix Vegas Pro 17 nudi 

izvoz u stotinama različitih formata s desecima već od strane softvera generiranim varijacijama 

postavki istih, uz mogućnost podešavanja, označavanja i spremanja dodatnih vlastitih varijacija 

spomenutih postavki od strane korisnika. Korisnik započinje proces izvoza uratka pritiskom na 

izbornik File > Export As, prilikom čega se pojavljuje prozor prikazan na slici 4.17. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

U svrhu objavljivanja na YouTube platformu, preporučeno je izvoziti uradak u MP4 (MPEG-

4 Part 14) ili WMV (Windows Media Video) formatima radi minimalnih veličina izvedenih 

datoteka na tvrdom disku unatoč vrlo poštenoj video i audiokvaliteti uratka nakon izvoza. 

  

Slika 4.17 Prozor za izvoz završenog uratka 
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4.9. Objavljivanje na platformi Youtube 

Završenu i izvedenu montažu (vidljivu u prilozima) korisnik ima mogućnost objaviti na web 

lokacijama gdje je sadržaj montaže poželjan - na filmski orijentiranim web platformama 

zabavnog sadržaja. YouTube je jedna takva web lokacija osnovana 2005. godine koja 

korisnicima omogućava objavljivanje, gledanje, dijeljenje, ocjenjivanje, dodavanje u liste, 

prijavljivanje, komentiranje na sadržaj i preplaćivanje na sadržaj drugih korisnika. Trenutno je u 

vlasti tvrtke Google i dugi niz godina je najveća web lokacija svoje vrste na svijetu. [14] 

Objavljivanje sadržaja na platformi YouTube započinje kreacijom Google korisničkog 

računa, uslijed čega se korisnik prijavljuje na isti, te pritišće gumb Stvori > Objavi video (eng. 

Create > Upload video) pri vrhu početne stranice web lokacije. Učinivši navedeno, korisnik će se 

susresti s novootvorenim prozorom koji zahtijeva odabir filmske datoteke koju korisnik želi 

objaviti. Nakon odabira filmske datoteke, pojavljuje se novi prozor koji zahtijeva unos željenog 

naslova filmske datoteke koja se objavljuje, opis iste, ključne riječi, sliku koja će datoteku 

predstavljati u pretraživanjima i odabir opcije vidljivosti datoteke u pretraživanjima, kako je 

vidljivo na slici 4.18. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Prilikom završetka procesa objavljivanja, korisniku će biti ispisana poveznica koristeći koju 

se dolazi do lokacije na kojoj je objavljeni video spreman za pregledavanje.  

Slika 4.18 Prozor za objavljivanje videa na YouTube platformu 
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5. Zaključak 

Proces videouređivanja je u današnjem svijetu neizbježan za bilo koju osobu zainteresiranu 

za svijet grafike i filmske industrije. Razvitkom umijeća izrade filmova i filmskog materijala 

rasla je i potražnja za boljom opremom, profesionalnijim stručnjacima, boljim scenarijima, 

boljim idejama i moderno boljim softverom. Među prvim skupinama stručnjaka koje su se 

odazvale rješenju spomenutoga problema je njemačka tvrtka Magix sa svojim vrlo nagrađivanim 

softverom za video i audiouređivanje filmskog materijala, Magix Vegas Pro 17. Razvojem 

tehnologije osobnih računala i napretkom, širenjem i društvenim prihvaćanjem svijeta videoigara 

pojavila se potražnja i želja igrača videoigrica za dijeljenjem svojih najdražih i najzabavnijih 

trenutaka s ostalim zainteresiranim igračima diljem svijeta, što je dovelo do razvoja softvera za 

bilježenje sadržaja videoigara. Igrači videoigara su s vremenom proširili svoju želju za 

dijeljenjem interesantnih trenutaka s ostalim igračima na želju ukrašavanja, personalizacije i 

videouređivanja sadržaja kojega su bilježili, te je na taj način došlo do spajanja svijeta 

videouređivanja i svijeta videoigara kroz medij videomontaža zabavnog sadržaja videoigara. 

Danas, igrači videoigara koji su postali korisnici softvera za videouređivanja svoja znanja i 

vještine stječu kroz raznolike medije i platforme, kroz međusobne razgovore i dijeljenja 

najnovijih otkrića tehnika, kroz knjige i literaturu, kroz praksu i mnoštvo isprobavanja i 

pogreški, sve s namjerom poboljšanja i izražajnijeg dijeljenja strasti za svojim hobijem sa 

ostatkom svijeta. Uvodni dio završnog rada upoznaje čitatelje sa softverom Magix Vegas Pro 17, 

popularnim u svijetu montiranja filmskog materijala videoigara, te s osnovama korištenja istog. 

Praktični dio završnog rada služi za demonstriranje korištenja dodatnog softvera radi detaljnijeg 

uređivanja projekata, kao i tehnika i standardnog radnog rasporeda montiranja filmskog 

materijala videoigara, izrade primjeraka slojevite grafike kojom montažeri često ukrašavaju 

svoje uratke, primjene vizualnih efekata unutar projekata, te korištenja vanjski generirane 

trodimenzionalne grafike u svrhu personalizacije uradaka. Spomenutim metodama montažeri 

dokazuju vlastite jedinstvenosti u rastućem moru neprestano objavljivanog sadržaja, dok 

potražnja za spomenutim sadržajem nezaustavljivo raste iz dana u dan. S obzirom na spomenuti 

sve veći rast industrije dijeljenja zabavnog sadržaja videoigara te potražnje za sposobnim 

igračima i videostručnjacima koji su usmjereni samo na bavljenje materijom videoigara bilo bi 

izvrsno kada bi se više pažnje posvetilo ovoj skromnoj umjetnosti radi doprinosa njezinom rastu, 

čemu brojni postojeći stvaratelji već doprinose širenjem svoga utjecaja. 

 

U Varaždinu, __________________      _________________ 

     Potpis studenta  
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Prilozi 

 

Montaža projekta završnog rada dostupna je za pregledavanje na web platformi YouTube: 

https://www.youtube.com/watch?v=gXuPP8KtmAA  

 

Montaža projekta završnog rada može se preuzeti s web platforme Google Drive: 

https://drive.google.com/drive/folders/1uT9MrScTOJjFp0X1NHyF3JIkiTKqkAeK?usp=sharing  

 


